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ОТВЕТСТВЕННОСТЬ СТОРОН:

01. На наличие изображений в RGB или LAB.
02. На наличие растровых изображений с низким разрешением (ниже 150 dpi).
03. На отсутствие обрезных меток.
04. На большое суммарное содержание красок (выше 320).
05. Составной черный в мелких текстах или графических схемах.
06. Правильность толщины корешка и наличие выборки под клеевое скрепление.
07. Совмещение файлов выборочного лака и наличия треппинга в них.
08. Корректность сюжета файла вырубки.
09. Невстроенные шрифты.
10. Наличие CMYK-овых изображений в работах, которые идут в печать в одну краску.
11. Корректное название дополнительных красок.
12. На соответствие обрезного формата: наличие в одном издании страниц разного формата.

01. На наличие вылетов за обрезной формат (мы можем это только случайно заметить).
02. На наличие элементов, расположенных близко к краю реза.
03. На совмещение разворотных сюжетов, в том числе 2 стр. обложки и 1 стр. блока или последней 

страницы блока и 3 стр. обложки. Гарантировать абсолютную точность данного совмещения даже при 
заложенных в верстке допусках затруднительно из-за технологических особенностей приклейки и 
обжима обложки и блока.

04. На верстку как таковую. Её аккуратность. Наличие/отсутствие изображений. Или какие-либо другие 
ошибки верстки и дизайна, цветокоррекцию.

05. На то, как отсмикуются ненужные пантоны.
06. Оверпринты, о которых вы нас не уведомили. В том числе на белые объекты, которые вообще при 

заданном на них оверпринте исчезнут (касается PS).

Мы предупреждаем наших клиентов об обнаруженных недочетах. Файлы могут уйти на доработку клиенту 
или в отдел допечатной подготовки.

Некачественность печатной продукции, как результат несоблюдения наших общих требований, не 
является ответственностью типографии.
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ОФСЕТНАЯ ПЕЧАТЬ

Должна быть обязательно включена опция Crop Marks с отступом от обрезного формата (offset) 
(т.е. файл должен быть с обрезными метками) и опция центрирования.

В файле должны быть вылеты за обрезной формат (минимум 3 мм).

PDF/PS должен не превышать по объему 1,5 Gb.

При красочности документа СМУК+дополнительные краски PDF-/PS-файл тоже должен быть 
композитным. Стандартный автоматичекий треппинг: black 100% overprint (на текст до 36 кегля), 
остальные цвета (в том числе PANTONEs) 0,15 pt.

Об особых параметрах треппинга сообщайте.

По умолчанию весь текст заданный 100% black (до 36 кегля) и иные объекты, заданные 100% 
black, печатаются ОВЕРПРИНТОМ. Учитывайте это при подготовке файлов к печати. Если в 
файле присутствует 100% black, и требуются иные настройки оверпринта для него – необходимо 
дополнительно сообщить об этом менеджеру.

Дополнительные цвета должны быть названы строго согласно библиотеке Pantone.

В разделе Adobe Photoshop подробно написано об оптимальной подготовке иллюстраций.

Там же написано по поводу ЦВЕТОВЫХ ПРОФИЛЕЙ.

Обратите внимание на верстку разворотных изображений в изданиях на термоклей. У нас имеется 
отдельная инструкция на эту тему. Просите у менеджера. Называется «Роспуск полос».

РИСКОВАННО делать PDF прямым экспортом из Abode Indesign CS4 (имеется статистика: у 
некоторых шрифтов при растрировании исчезают значки переносов и дефисов). Пишите сначала PS.



назад к оглавлению

ОБЩИЕ ТРЕБОВАНИЯ К ВЕРСТКАМ:

Принимаем работы из Adobe InDesign / Illustrator (не выше CS5 - PC.),  CorelDraw (не выше 13)

Допускается разбивать 
документ максимум на 5 версток. Все странице в верстке должны идти строго по порядку.

Предельное суммарное содержание красок для нашей типографии НЕ ДОЛЖНО ПРЕВЫШАТЬ 330%. 
Учитывайте это при цветоделении. (Подробнее об этом см. в разделе Photoshop).

Самораскрывающиеся архивы (.exe) не принимаются.

 Цветовые профили игнорируются.

Помните о составном черном как залоге насыщенного цвета. Оптимально: Cyan - 40%, Magenta - 30%, 
Yellow - 30%, Black - 100%.

Дополнительные цвета должны быть названы строго с  (произвольные 
названия не допускаются).

Большие объекты черного цвета необходимо раскрашивать составным черным цветом. 100% Black, 
положенный overprint-ом, не имеет достаточной кроющей способности, и Вы рискуете получить 
элемент, сквозь который будет проглядывать фон.

Не закрашивайте элементы цветом Registration.

Создавая свою работу,  т. е. если 
Вы хотите после того, как какое-либо изделие будет отпечатано и обрезано, оно было размером, 
например, 210×297, то и документ должен быть такого размера. Выводите за край печатного поля 
элементы, которые предназначены «под обрез».  Это касается всех 
программных пакетов, которыми Вы пользуетесь.

Обложка для издания под термоклей должны быть сверстана 
Толщину корешка можно рассчитать по таблице (см. ниже) или узнать у менеджера.
Должны быть метки корешка за обрезным форматом.
Должна быть сделана выборка под клей: белое поле по 3 мм влево и вправо от корешка, который тоже 
должен остаться незакрашенным.
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ОБЩИЕ ТРЕБОВАНИЯ К ВЕРСТКАМ:

Принимаем работы из Adobe InDesign / Illustrator (не выше CS5 - PC.),  CorelDraw (не выше 13)

Допускается разбивать 
документ максимум на 5 версток. Все странице в верстке должны идти строго по порядку.

Предельное суммарное содержание красок для нашей типографии НЕ ДОЛЖНО ПРЕВЫШАТЬ 330%. 
Учитывайте это при цветоделении. (Подробнее об этом см. в разделе Photoshop).

Самораскрывающиеся архивы (.exe) не принимаются.

 Цветовые профили игнорируются.

Помните о составном черном как залоге насыщенного цвета. Оптимально: Cyan - 40%, Magenta - 30%, 
Yellow - 30%, Black - 100%.

Дополнительные цвета должны быть названы строго с  (произвольные 
названия не допускаются).

Большие объекты черного цвета необходимо раскрашивать составным черным цветом. 100% Black, 
положенный overprint-ом, не имеет достаточной кроющей способности, и Вы рискуете получить 
элемент, сквозь который будет проглядывать фон.

Не закрашивайте элементы цветом Registration.

Создавая свою работу,  т. е. если 
Вы хотите после того, как какое-либо изделие будет отпечатано и обрезано, оно было размером, 
например, 210×297, то и документ должен быть такого размера. Выводите за край печатного поля 
элементы, которые предназначены «под обрез».  Это касается всех 
программных пакетов, которыми Вы пользуетесь.

Обложка для издания под термоклей должны быть сверстана 
Толщину корешка можно рассчитать по таблице (см. ниже) или узнать у менеджера.
Должны быть метки корешка за обрезным форматом.
Должна быть сделана выборка под клей: белое поле по 3 мм влево и вправо от корешка, который тоже 
должен остаться незакрашенным.

, Corel Draw
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КАК РАССЧИТАТЬ ТОЛЩИНУ КОРЕШКА:

01. Выяснятете, на какой бумаге печатается блок. Например, 90 гр/м2, глянец.

02. Смотрим в нашу таблицу. Выясняете толщину данной бумаги. Это 0.065.

03. Умножаете толщину бумаги на количество страниц в блоке (например, у Вас в журнале 72 стр.) и 
делите на 2. Получаете толщину корешка без учета клеевого скрепления: (72 х 0.065) : 2 = 2,34 мм

04. К полученному результату прибавляем 1 мм (корешок утолщается за счет клеевого скрепления и 
толщины бумаги самой обложки). Получаем 3.34.

05. Округляем. Получаем 3 мм.

80 90 100 105 115 120 130 140 150 157 160 170 180 190 200 250 300

Офсетная 0,106 0,116 0,126 150 0,170 0,019 0,200

Глянцевая 0,064 0,083 0,091 0,107 0,124 0,148 0,185 0,228

Глянцевая пухлая 0,064 0,068 0,085 0,092 0,099 0,101 0,120 0,125 0,135 0,143 0,152 0,173 0,235

Матовая 0,074 0,094 0,107 0,125 0,141 0,168 0,225 0,282

Матовая пухлая 0,072 0,082 0,097 0,105 0,114 0,116 0,135 0,143 0,153 0,164 0,177 0,200 0,260

Ставьте метки бига, фальца, выводя их за обрезной формат, как и все прочие элементы, 
предназначенные под обрез. Минимальное расстояние за обрез - 3 мм.

Не принимаем работ без меток бига/фальца.

Не располагайте информационно-значимых элементов близко к краю реза: не менее 4 мм.

Верстая разворотами, четко (по цифрам) позиционируйте элементы левых и правых полос. Т. е. 
так, чтобы элемент, например, с левой полосы не залезал на правую, если ему туда залезать по 
дизайнерскому замыслу не назначено. Нечеткое позиционирование элементов приводит к появлению 
лишних элементов на стыке страниц при спуске полос.

Если вы готовите многостраничную публикацию (больше 4-х страниц), например, А4 формата, 
НЕ ВЕРСТАЙТЕ ЕЁ РАЗВОРОТАМИ А3 формата. Хотите видеть развороты -выставляйте опцию 
Facing Pages (в Corele тоже есть такая опция). Соответственно конечный pdf тоже должен быть 
постраничным, а не разворотами.

Под пружину верстайте постранично, учитывайте расстояние для пружины (1 см).

Не рассчитываете на идеальное совмещение мелких элементов, закрашенных составным цветом. Или 
мелких белых элементов, лежащих на составном фоне
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Файлы должны быть предоставлены в цветовых моделях: CMYK, Grayscale, Bitmap

Растровые файлы должны быть предоставлены в следующих форматах:

Если это EPS обратите внимание на параметры Encoding (Binary).

Достаточным разрешением для растровых изображений является 300 dpi. 

Наша типография единственная в России одна из немногих в мире, печатающая линиатурой 340.
У данной передовой технологии есть некоторые ограничения для печати офсетным способом.
Критичные сюжеты для печати высоколиниатурными растрами:

01. Черно-белые иллюстрации выполненные CMYK, площадью запечатки более 15 см2.

02. Составные серые, фоновые цвета с интенсивностью от 30% растра и выше (самые критичные 50%-70% 
растра), площадью запечатки более 15 см2.

03. Холодные оттенки с содержанием синего (C) и черного (К) (пример: 85% Сyan + 30% Black) с 
площадью запечатки более 15 см2.

Мы готовы оказать на этапе подготовки файлов квалифицированную консультацию и поддержку. 
Есть возможность растрировать гибридно, то есть печатать на одном листе элементы имеющие разную 
линиатуру.

Разрешение штриховых изображений должно находиться в пределах от 600 до 1200 dpi.
Параметры баланса по серому:
75%: Cyan — 75, Magenta, Yellow — 64
50%: Cyan — 50, Magenta, Yellow — 40
25%: Cyan — 25, Magenta, Yellow — 19
При переводе изображений в CMYK следите за установкой Total Ink Limit (max 330%).
Для текстовых слоев, содержащих 100-процентный черный цвет, можете задать режим смешения 
пикселов Multilply. Это обеспечит Вам overprint на черный текст (в растровых изображениях 100% 
черный иначе не оверпринтится).
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Собирайте все используемые в верстке шрифты и изображения. Для этого используйте опцию
File->Pасkage. Проверяйте, все ли шрифты были собраны таким образом.

Полезна опция File—>Preflight. Так вы можете проверить свой документ на наличие ошибок 
(отсутствие подгруженных шрифтов, RGB).

Не допускайте помещения в одну публикацию файлов изображений с одинаковыми названиями.

Помещая в верстку прозрачный PSD-файл следите за тем, чтобы он НИ В КОЕМ случае не лежал 
поверх других ВЕКТОРНЫХ элементов. (Последние потеряют свои векторные характеристики в PS-
файле).

Верстайте в обрезной формат. Выводите за край печатного поля элементы, которые предназначены 
«под обрез».
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Прикладывайте шрифты или переводите текст в кривые. Иногда большие объемы текста лучше 

Верстайте в обрезной формат. Выводите за край печатного поля элементы, которые предназначены 
«под обрез». Если обрезной формат Вашего издания, например, А4 НЕ ДЕЛАЙТЕ ДОКУМЕНТ 
ФОРМАТОМ А3 И НЕ ВЕРСТАЙТЕ РАЗВОРОТАМИ. Если хотите верстать разворотами, то установите в 
Layout->Page Setup->Layout->Facing Pages.

Рекомендуем растрировать Corel-овские градиенты и эффекты.

Например, если хотите вставить в Corel таблицу, например, из Excel, копируйте её и вставляйте через 
опцию Paste Speсial->Windows Metafile. И потом отредактируйте полученный результат.

Используйте меню Document Info, чтобы проанализировать содержимое Вашего документа.

Непременно применяйте к таким изображением опцию Bitmap-> Resample до 450 dpi
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На вывод кроме файла документа Adobe Illustrator необходимо подавать все заверстанные в полосы 
(Linked Images) изображения, а лучше сделать их EMBEDDED, и все использованные шрифты.

Наша рекомендация — преобразовать шрифты в кривые (curves) (Type->Create Outlines).

Используйте опцию Select Text Objects или Type-> Find Fonts, чтобы убедиться, что вы перевели все 
тексты в кривые.

Используйте меню Document Info, чтобы проанализировать содержимое Вашего документа.

Верстайте в обрезной формат. Выводите за край печатного поля элементы, которые предназначены 
«под обрез». Включите опцию Object-> Crop Marks-> Make.

Не оставляйте в файлах текстовых точек вставки: Select Stray points -> Delete.

Старайтесь не прибегать к растровым эффектам. Также имейте в виду, что опция Expand Appearance 
превращает, например, тень в прозрачный СМУК на 72 dpi. Лучше воспользоваться опцией растеризации.

и соответственно увеличивает время на его растрирование.

Во избежание появления ломаных линий и пилы устанавливайте параметр Output в палитре Attributes 
равный минимум 800 dpi.

При сохранении сложной векторной графики активизируйте кнопку Split long path.
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ЦИФРОВАЯ ПЕЧАТЬ

ОБЩИЕ ТРЕБОВАНИЯ:

01. Подходящие форматы макетов:

Adobe Acrobat (PDF, без внедрённых цветовых профилей, без спусков)

Adobe Illustrator (AI и EPS)

Adobe Photoshop (PSD и TIFF без слоёв)

Макеты в любых иных форматах принимаются по согласованию (рекомендуется делать экспорт в 
один из перечисленных выше форматов).

02. Размер в макете должен соответствовать печатному оттиску (1:1).

03. Припуски под обрез – обязательны при печати без полей:

одностороняя печать – не менее 4 мм со всех сторон

двусторонняя печать – не менее 5 мм со всех сторон

брошюры – не менее 5 мм, включая внутренний край, без спусков полос

04. Отступы (расстояние от линии реза и/или сгиба до содержимого) – не менее 4 мм с каждой стороны.

05. Цвета в цветовой модели CMYK.

01. Евробуклеты предоставляются в виде разворотов. Ширина полос: 97-100-100 мм на внешнем 
развороте, 100-100-97 мм на внутреннем развороте. Общий формат А4 горизонтальный.

02. 
симметрично с каждой стороны, включая внутреннюю.

03. Блинтовое тиснение в макете обязательно должен быть векторный контур тиснения. Для растровых 
макетов он прикладывается отдельно в векторном файле (растровый файл включен). Стандартные 
влёты и вылеты обязательны.

04. Биговка/фальцовка обязательны метки за пределами как обрезного формата, так и вылетов.

01. Не рекомендуется делать рамку по периметру макета близко к краю, т.к. допустимые отклонения 
становятся визуально очень заметны.

02. Избегайте больших полей с равномерной заливкой или слабым градиентом. Такие объекты могут 
печататься неровно. Если они необходимы, накладывайте поверх легкую текстуру или полупрозрачное 
изображение.

03. Все служебные метки не должны заходить на изображение, в том числе на вылеты.
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ТРЕБОВАНИЯ К ВЕКТОРНЫМ МАКЕТАМ:

01. Текст в кривых.

02. Цветовая модель CMYK (включая растровые объекты).

03. Растровые эффекты (прозрачности, тени и др.) должны быть растрированы с разрешением 300 dpi.

04. Растровые изображения в масштабе 1:1 (предварительно повёрнутые, скадрированные и 
отмасштабированные в растровом редакторе).

05. Overprint у всех объектов должен быть снят.

06. Толщина линий не менее 0,15 мм.
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ТРЕБОВАНИЯ К РАСТРОВЫМ МАКЕТАМ:

01. Масштаб растровых файлов – 1:1

02. Разрешение:

цифровая печать, офсет: 300 dpi

широкоформатная печать интерьерного качества: 150-300 dpi

широкоформатная печать экстерьерного качества: 36-72 dpi

03. Цветовая модель CMYK, формат TIFF (без сжатия, LZW или ZIP сжатие)

04. Без слоёв (единственный слой Background), без альфа-каналов

05. Преобразование RGB в CMYK производится с использованием профиля Euroscale Coated v2. 
Использование профиля по умолчанию (U.S. Web Coated) может привести к искажению цвета
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УФ-ЛАК

Минимальная толщина линии 0,5 мм. Вылеты 3 мм. В местах фальцовок, биговок и на корешке 
каталогов на скрепку необходимо делать выборку 1,5-2 мм. Для каталогов на термоклей необходима 
выборка по всей площади корешка плюс по 3 мм для клея с обеих сторон корешка. Клеевые клапаны у 
диджипаков, ключниц, коробок, папок не должны лакироваться.

Требования к объемному лаку: максимальная площадь сплошной заливки 50х50 мм, минимальная 
толщина линий для объемного лака – 1 мм. При подготовке макета нужно помнить, что лак не должен 
доходить до линии реза на 1,5-2 мм, в местах биговок, фальцовок обязательна выворотка 3-4 мм. 
Клеевые клапаны у диджипаков, ключниц, коробок, папок не должны лакироваться.

При наложении УФ-лака на офсетное изображение следует избегать толщины линии менее трёх 
миллиметров, при этом треппинг изображения на УФ-лак должен составлять 0,3 мм.

Если изображение, на которое накладывается выборочный УФ-лак, светлее, чем фон, то пленки на лак 
выводятся МЕНЬШЕ этого изображения на 0,3 мм с каждой стороны. Если изображение темнее, чем 
фон, то пленки на лак выводятся БОЛЬШЕ на 0,3 мм с каждой стороны.

Если лак не накладывается поверх изображения, а печатается независимо, то минимальная толщина 
линии составляет 0,5 мм.

При создании макета следует избегать большого разброса мелких объектов на площади печатного 
листа. Желательно, чтобы лакируемые объекты располагались группой в одной части листа, либо 
заполняли всю площадь листа.
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ТАМПОПЕЧАТЬ

Технология нанесения с помощью тампопечати требует ширины линии или пробела 0,2мм.

Размер нанесения:

На ручки — длинна не более 55 мм, высота не более 7 мм
(размер на нестандартные ручки утачняйте у менеджера).

На плоские поверхности — круг с диаметром 55 мм.

На цилиндрические поверхности — круг с диаметром 45 мм. Высота логотипа при нанесении на 
неровных поверхностях рассчитывается по формуле: D (диаметр изделия) × К (коэффициент для 
изделий до 5 см = 0,7, для изделий с большим диаметром 0,5).

При многокрасочной печати возможность заложения треппинга — 0,2 pt.

В надписях приветствуются шрифты без засечек с положительным разрежением букв на 5-10%. 
Минимально возможная высота шрифта — 0.8 мм.

Не рекомендуются градиентные заливки.

Печать светлым по темному рассчитывается с учетом нанесения белой подложки, и расценивается как 
дополнительный цвет.

Недопустимо размещение изображения в непосредственной близости с выступающими частями 
изделия (клип, кнопка и т.д.), расстояние зависит от изделия и может быть рекомендовано технологом 
или дизайнером.

При печати на габаритных изделиях (кружках, бокалах) с большой кривизной возможно искажение 
по краям изображения. Следует учитывать это и избегать применения длинных горизонтальных или 
вертикальных элементов
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ТИСНЕНИЕ
ФОРМАТ ФАЙЛОВ

векторный в CorelDraw до версии X3 включительно (расширение файла *.cdr) или EPS сделанный в 
иллюстраторе до версии CS6 включительно.
имя файла макета не должно содержать спецсимволов (@#$% и т.д.).

ИСПОЛЬЗОВАНИЕ ШРИФТОВ.
Все символы должны быть переведены в кривые.

ИСПОЛЬЗОВАНИЕ ЦВЕТА.
Цвет в макете должен быть только черно-белый на 100%, позитив для тиснения логотипа (черное 
изображение как раз то, что тиснится) и негатив для конгрева (черное поле по 10мм с каждой 
стороны изображения). В макете не должно быть оверпринтов и лишних элементов изображений. 
ользование цвета.

МАСШТАБ.
Макет в файле должен быть в масштабе 1:1. При подготовке макета учитывайте термическое 
расширение металла, т.е. магния.

И, НАКОНЕЦ, САМОЕ СЛОЖНОЕ.
тисним фольгой бумагу, картон, бумажные пакеты, папки - рекомендуем обеспечить минимальную 
толщину линий 0,5 мм, а выворотки (например, дырки в букве “я”) – не менее 2 мм в диаметре.
тисним без фольги (блинтовое тиснение) изделия из кожи и кожзаменителя (ежедневники, 
планинги, портмоне и т.п.) - рекомендуемая минимальная толщина линии 1 мм, величина выворотки 3 мм.
тисним фольгой изделия из кожи и кожзаменителя (ежедневники, планинги, портмоне и т.п.) – 
рекомендуемая минимальная толщина линии 1 мм, величина выворотки 5 мм.

Минимальные размеры – это рекомендации. Их выполнение позволяет улучшить восприятие оттиска.
Наличие в макете линий менее 0,2 мм на клише не гарантируется.

ОГРАНИЧЕНИЕ НА ВЫБОР РАЗМЕЩЕНИЯ ЛОГОТИПА НА ИЗДЕЛИИ.
Не допустимо размещение изображения в непосредственной близости с выступающими частями 
и краями изделия (портфели, сумки, папки и т.п.). Расстояние зависит от изделия. К листовой 
продукции не относится.
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ШИРОКОФОРМАТНАЯ ПЕЧАТЬ
ФОРМАТ ФАЙЛОВ

.tiff

.psd (Photoshop)

.cdr (Corel DRAW)

.ai, .eps ( Illustrator)

Макеты должны быть выполнены в размере 1:1, ( если в масштабе - указать масштаб)
К макету желательно прилагать дополнительный файл в формате .jpeg для просмотра.

ТРЕБОВАНИЯ К РАСТРОВЫМ ФАЙЛАМ.
Цветовая модель CMYK.
Все слои должны быть сведены в единственный слой – Background, без дополнительных альфа-каналов (Channels), 
путей (Paths) и без сжатия.
Оптимальный объем файла - до 200 Мб.
Разрешение растровых изображений (при размере 1:1):

 » для печати изображений размером 6х3 м и более - 50-100 dpi;
 » для печати изображений сити-формат (1,2х1,8м) – 100-180 dpi;
 » для печати изображений фотокачества – 200 – 300 dpi;

Если предоставляете файлы в формате .psd со слоями для возможного дополнительного редактирования, то 
шрифтовые слои должны быть растрированы.

ТРЕБОВАНИЯ К ВЕКТОРНЫМ ФАЙЛАМ.
Цветовая модель CMYK;
Одно изображение на печать – один файл (без страниц).
Все шрифтовые объекты должны быть переведены в кривые.
Макет не должен содержать видимые или невидимые объекты, выходящие за размер печати.
По границе запечатываемого изображения должна быть рамка (а не только установка формата документа)
Все контуры (обводки) толщиной более 2мм необходимо перевести (конвертировать) в объекты (особенно в 
шрифтах).
Если представляете макет 1:10, то проследите, чтобы в контурах (обводках) была установлена опция – Scale with im-
age (масштабировать с изображением).
Эффекты в файлах Corel Draw должны быть растрированы, т.к. нерастрированные эффекты и тени могут привести к 
некорректной печати и искажению изображения.

ВНИМАНИЕ:
Если в макете повышенные требования к отдельным (индексированным) цветам, то необходимо указать цвет по Pan-
ton Process , а также его процентное соотношение в модели CMYK.
Черный цвет должен быть составным ( например: C65,M65,Y65, K95), в противном случае цвет получится темно 
серым, а не черным. Это относится и к производным цветам с процентным содержание черной краски.
Избегайте большого масштабирования Bit-map-вых вставок в векторных программах - это отражается на качестве 
изображения.
Разрешение печати и разрешение самого файла - разные понятия.
Перед тем, как отправить макет, проверьте его изображение в программе Photoshop, чтобы убедиться в правильном 
отображении информации.
Для достижения высокой степени совпадения по цвету при печати многоцветных и сложных изображений, 
рекомендуется печатать цветопробу.

ПРИ ПОДГОТОВКЕ ФАЙЛОВ СЛЕДУЕТ УЧИТЫВАТЬ.
Обратите внимание на то, что если вы импортируете растровые картинки в Corel, то не следует вставлять файлы в модели 

RGB. Только файлы с цветовой моделью CMYK. Иначе при экспорте Corel сам сделает цветоделение в модель CMYK с непред-
сказуемым результатом. Поэтому перед тем, как помещать растровую картинку в макет, обработайте ее и внесите изменения в 
Photoshop. Не используйте эффекты прозрачности, тени и прочие эффекты в векторных файлах – они моделируются, програм-
мой Corel, в цветовом пространстве RGB и тоже будут некорректно экспортироваться.

Предоставление макетов для полноцветной широкоформатной печати в растровом формате TIFF является лучшей гаран-
тией от неожиданных изменений в файле в процессе печати. Но возникает трудность при передаче файла нам через Интернет. 
При подготовке файла в формате TIFF необходимо свести все слои в один слой Background и удалить все дополнительные 
каналы и пути, которые создавались в процессе работы над макетом.

Разрешение файлов должно быть оптимальным. Недостаточное разрешение файла приведет к тому, что будут заметны 
пиксели при изготовлении рекламных щитов, границы линий будут зубчатыми. Избыточное разрешение файлов значительно 
увеличит работу над файлом и его обработку, но качество отпечатка при этом не изменится. Для больших брандмауэров, 
которые устанавливаются на высоте и зрительно воспринимаются с большого расстояния можно снижать разрешение до 30-
50 dpi. Если пиксели и видны с близкого расстояния, то при удалении на 10-20 метров они становятся неразличимыми. Немало-
важным является качество и разрешение исходных картинок, которые вы помещаете в ваш макет для изготовления наружной 
рекламы. Необходимо учитывать, что изображение, которое прекрасно в формате А4, будет таким же в формате 3×6 м. и более.
продукции не относится.
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ШЕЛКОГРАФИЯ
01. Макеты принимаются с расширениями: *.ai (версии от CS4 и ниже), *.cdr (версии от 15 и ниже), *.eps 

(версии от CS4 и ниже). 

02. Макеты  никаких растровых изображений, растровых эффектов 
(прозрачность, тени и т. д.), градиентных заливок.

03. Макет должен содержать в себе только векторные элементы.

04. Минимальная толщина линии  линии тоньше не воспроизводятся и 
следовательно будут утолщаться, либо удаляться дизайнером при подготовке макета. То же самое 
касается толщины линий в шрифтах – очень тонкие шрифты не пропечатываются и утолщаются. 

05. Крайне не рекомендуется использование системных шрифтов (например, Arial, Times New Roman 
и т.д.). Используйте альтернативные шрифты. Так же не рекомендуется использоваль шрифты 
размером меньше 5 пт (при «выворотке» не менее 6-7 пт).

06. В файле, присылаемом в типографию, все шрифты должны быть переведены в кривые (ИСПРАВЛЕНИЕ 

приложены к макетам.

07. Если в макете присутвует фоновое изображение, либо графические элементы, которые должны быть в 
край готового изделия, то они должны быть сделаны «на вылет» по 3 мм с каждой стороны (например, 
имеем визитку размером 90 на 50 мм с фоном, следовательно фон должен быть – ).

08. Текст и значимые элементы в макете, которые не должны быть зарезаны в готовом изделии, должны 
отступать внутрь от края готового изделия на 4 мм с каждой стороны.

09. Расстояние между элементами не должно быть менее 

10. Если в готовом изделии присутствует УФ-лакировка, термоподъем, конгрев, тиснение или вырубка, то 
продублировать эти элементы на отдельном слое. Слишком мелкие или тонкие объекты не тиснятся, 
не конгревятся и на них не ложится термоподъем.

11. На больших плашках лучше не использовать термоподъем, потому что он плохо запекается при сушке. 
Так же термоподъем не используется на элементах на «вылет».


